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KAIST I=C
Target system overview

= Coffee Vending Machine

— Provide black, sugar and milk coffee

* We consider the only simple functions such as “receiving coins”,
“making coffee”, and “provide coffee”

Sugar coffee(10won)

5won, 10won
Black coffee(5won)

Coffee Vending Machine(CVM)
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Overview
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KAIST = B
CVM Requirements
= 1. CVM Requirements

— 1.1 Coffee Requirements
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— 1.2 Change Requirements
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KAIST

CVM Requirements Structured
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KAIST | —==
CVM Requirements Structured w/ =~

Parameters & Attributes

Low
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KAIST | ==
CVM Requirements Structured w/

Numerical Parameters
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KAIST J-c
Introduction of DOORS

= Doors is
— Dynamic Object-Oriented Requirements System

— Requirements management tool

» Designed to capture, structure, analyze, and manage system and/or
software requirements throughout the systems development life cycle

— Computer database program

» Scalable for any project size and supports requirements traceability
among the requirements and to/from the external specifications

= Benefits

— Most comprehensive support for recording, structuring, managing,
and analyzing requirements and their traceability
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KAIST

DOORS login

I o

Software Procass Imorovement Ganter

€ Login - DOORS |

Datahase:]?ﬁﬁ??@ 43, 245,155

Username | |sjwoo

Fassward | |++rrey

0]:8 I Cancel

£ DOORS Database: / - DOORS N=1E
File Edit Miew Favorites Tools SYMWERGY/Change Integration  TalU  Help
EEES | € E | RE ||
Faunrites.| Ll Location: |fs -
- ORS Database Marne | Type | Descripti
# Company project # Company project Project
3 DC—|HtE!§IFEtiDIj [C3DC-Integration Falder
i3 DOORSExercise (JDOORSExercise Folder DOORS
[0 TelelogicExercise (1 TelelogicExercise Folder DOORS |
4| | 2
- | Username: siwoo \User type: Database Manager || y
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KAIST

Folders and projects concepts(1/2)

= Database structure example

* Only projects and folders are
allowed at the root level
» Data can be organized in:
— Folders are used to structure
data within the project
» Folders may contain Sub-folders,
Projects, Modules
— Projects are the ‘work area’, (a
special type of folder) to manage

0= data for a working project
|  Projects may contain Folders,
_ Subprojects, Modules
= Folder — Modules with your current data
- = Project
= Module
2007-03-22 KAIST SELAB 11/68



KAIST

Folders and projects concepts(2/2)

= Using folders and projects

E DOORS Database: / - DOORS -

File Edit Miew Favorites Tools SYMERGY/Change Integration  TAL
Help
Eal: =
Favorites: | ﬂ LG o Tivision,/Cars,/B
ROOORS Database || Mam | Type
8 Company project ompany project Project
(1 Change Proposal Syst DC-Integration Falder
+-[] Company Documents DOORSExercise Falder

-2 Divisions
=-[23 Commercial Divisio
-7 Cars
--[Z7 Big Cars
Minivan
- Station W

+-[27 Little Cars
+-[7 Scooters
+-[7 Stereo Systems
+-[27 Trucks
+-[Z7 Federal Regulations
J 3 Industry Standari:la -
4 3

Usernarme: sjwoo

Folder

logicExercise

al |

User type: Database Manager

_~+ Use a Project for : i
— Data related to a specific project,
product, or process for a team

— Data that is subject to a high
degree of change

— Data that may need to be
partitioned out for distribution to
other databases

— Data that needs to be backed up as
archive

~~e« Use a Folder for : &=
— Creating structure and organization
— Data that is not likely to change
— Data that does not need to be
distributed to other databases
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KAIST
Folder and project(1/4)

= Create folder

— File > New = Folder or Mouse right button menu

— Folder name : “CoffeeVendingMachine |ID”

File  Edit iew Favorites  Tools  SYMERGY/Chapge [gptegration. TaU Help
Eolder, .,

T | gEiw) 1) =104
T ranwart tn Faldar

Descriptior:

Mame

I o

Software Process Imorovemant Gantar

g DOORS Database: / - DOORS N= Tl ¢ New Folder - DOORS x|

» |LofteeVendinghMachine

—— : : | 0] Cancel Help
+ [ Company [ SR faject
23 DC-Integrat = . FTOEE,, older
: Froperies, ., |
% gglglzgiiexercise o1 Formal Module, 'Dlder oo
Link Madule. ., alder DOORS Re
Descriptive Module,
Project Startup Wizard, ,,
4| | -~
Create a new folder, e
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KAIST
Folder and project(2/4)

= Create folder(cont’d)

E DOORS Database: / - DOORS _ EEI

File Edit Miew Favorites Tools SYMERGY/Change Integration  Tal  Help
| EmEGEsS Y| RE B

I o

Software Procass Imorovement Ganter

Favorites! |
% DGDHS DatahaSE [ YT ! Tlllnl:l ! r'ln:n:-ﬁrilnﬁnr
l Faolder
T T e Eerree
[CADC-ntegration Falder
[AD0OORSExercize Folder DOORS
[ATelelogicExercise Folder DOORS Re
4| | -
- |Usernarne: sjwoo User type: Database Manager | Y
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KAIST I=C
Folder and project(3/4)

= Create project
— File > New - Project or Mouse right button menu
— Project name : “Requirements of CVM_ID”

E DOORS Database: /CoffeeVendingMachine - DOORS - O = E New Project - DOORS E

File Edit Miew Favorites Tools SYMERGY/Change Integration  Talu  Help

_ Falder Mame [Requiremnents of CVM
Froject,.,, 0 intionk o £ =
e hhachine escriptio ! Z

1
- o DOORS Database MNarme | Type | Descriptior Ok —| Cancel Help

=] ofiee vendiaabdaching

+-[E Company F""Er
+- [ DC-Integr Properties. . Project,

+- [ DOORSE:
+-[.7] TelelogicExercize

Formal Module,,,
Link Module, ..
Descriptive Module,

Project Startup Wizard, .,

Create a new orojiect.
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KAIST I=C
Folder and project(4/4)

= Create project(cont’d)

E DOORS Database: /CoffeeVendingMachine - DOORS

File Edit Miew Favorites Tools SYMERGY/Change Integration Tal  Help
EEEs | § (B e E 2

Favorites! | LI Location: |anﬁeeUendingMachine R
E% DOORS Database hlarog I Tuns I Doscrintior
+-{4 Coffee’endingtachine Requirements of CYM Project CyMMH 2R
28 Company project

[C3 DC-ntegration

-1 DOORSExercize

#-[Z7 TelelogicExercise

‘| | -

. |Username: sjwoo User type: Database Manager | Y
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KAIST Iae
Formal module concepts

= A formal module is a container for information
(requirements, graphics, etc)
Typically structured and displayed as a document
May be structured and displayed as a data file

E Formal module /DC_II/CS 550 Software Engineering Project’ current 0.0 - DOORS
File Edit Wiew Insert Link Analysis Table Tools User Change Management TaU  Help

.'_IF_-erul mdule "/ Training Car Project )’ i
E@MWMWMWT#ETHH-LWW

|HEE & B v =t = 3 g E | O
E a ﬁ ;. [h E # PR TTEy B OF U = [Standard view = [Alllevels =] 3 AT 2w B
. = L5 560 Softwara Enginesring Project iy |C5 550 Software Engineering Project =
s " ol = 1 Business Purpose J IR Em
- A - pose
| Standaid view x| |anteves  x]| e &0 HZDES IS5t F0IAEAL 14 [ 3 System Context Diagram
- Z Domain Entities |
Io I Car - i Bg;ﬂam Entiies= LISt 2101 7 144 System Context Diagram2 CHS 1t 20| SEEICH
HERE MQKH?}UV\EA) = mos = A4 T Dy o Mo == 9|3 =.
| = 145 User= ZESHINEWS T2 M L HAIZHES R B H2AME, Tip, AFR HAITH 2EE 26l GenS ¢
H A o H SHRE
=R1 | 1 Introduction 42 20 08 s womee (Rungen)
CSR133 This module contains the user requirements for a new car to 146 Administrator= HIAITH 22| S 5l GenS LRSI (Admincar)
avallable b'f 1 .ﬁl..q.ﬁt 2006, 147 TrafficCorporation 2 (HELDE3AF 22 4 Gen0| 275H= E2E HSstch
CSRZ | 2 Lber w;ms 142 GenZ TrafficCorporation2] (HEDE B2 E 0|2 (Requestinfo)sHH User 2| HE0E 2 A |

Al
(Runtar)E H2l5t0 208 M S(Result) ECE S & GenS User2} Administrator2] HLAITH 2621 HH] A
(Runcen, Adwinced S HMelstn 2UE HS(Resuh ettt

csr3 | 2,1 Nationalities )

me L&
= mer ZLE Hg 24

CSR118 |The car will be used in the following countries: LK, USA, Nor administator= H AT 21012 149 System Context Diagram:= <J22»20 &2 2HIE TICL
= aﬁ!Eg
Eastern El.rﬁpe, W g:ﬁgcTDr;Dﬁ?cr%‘oorgora[t}i{onﬂ [Hé‘ 151 <<actor>> “<<actoEs
csRs | 2,2 User si Sy omest Dagram = < User [—meen Gen |2 Traffic Corporatior
. siZes 0
CSRA |People come in all shapes and sizes. The car must be suitab S e
maximum and minimum sizes 1.3 m to 2 m weighing 35 kilog
kilograms.
CsR7 | 3 Renuniremente AdrminGon Rosult -
4| | KN — 2l 4] | e

Sername: Sjwoo Exclusive edit mode
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KAIST =
Formal module(1/4)

= Two kinds of formal module
— General formal module
— Formal module based on template General formal

= Create formal module module
— File > New = Formal Module or Mouse right button menu

11 . 17
— Formal module name : “CVM requirement_ID
— E New Formal Mrdule - D... E
£ DOORS Database: /Requirements of CYM - DOORS HE=E
File Edit Wiew Favorites Tools SYNERGY/Change Integraion TAU Help Marng: |LM Requirernents
Ealli] (Sl =B Descriptiof: =t 2
Favarites: | ﬂ Lacation: |,-"F|equirements of CWhd I~ | Dhject ||jE Ters
= &, DOORS Database Mame | Tvpe | Descriptior Start at: [1 Prefis:
—-[.] CoffeeMendingMachine
= Hequirern entgail
+-[@@ Cornpany projec RSN Ealder... Template
+ DC -t 1 \ Project,..
+ % DOORSEvereiss _ EroPeries. . — I Use a template
+-[Z7 TelelogicExrercize (CfeiEEL] EUEIEIEN S
TNk maaaie, .. |
Descriptive Module, ,, —
Project Startup Wizard. .,
ormal module OK | Cancel | Help |
based on
« | o Ll | template*
18/68
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KAIST I=C
Formal module(2/4)

= Create formal module(cont’d)
— Result of creating a general formal module

E DOORS Database: /Requirements of CYM - DOORS - O =

File Edit Miew Faworites Tools SYMERGY/Change Integration TalU  Help
FEEs 8 B 5 9.8 o

Favaorites: | ﬂ Location: |,-f’Hequirements af Wk hd|
- o DOORS Database e T
=-_1 CoffeeVendingMachine | | et eGEn == Formal
23 Requirernents of CY

+-[E8 Company project
+-[_] DC-Integration
+-[_] DOORSExercise
+-[_] TelelagicExercize

1 o L 2

Usermame: sjwoo User type: Database Manager

2007-03-22 KAIST SELAB 19/68



KAIST

Formal module(3/4)

= Formal module based on template
— Create formal module “using a template”

B New Formal Module - D... E

Mame: | Template module

I o

Software Procass Improvement Ganter

Description: |

Object ldentifiers

Start at: Prefis:
Template

v Use a template

|

Ik | Cancel

Browse,

Help

E Insert Template - DOORS E

select the template yvou want to use,

-1-|_1 Design Caontral
+-27 Architectural Design Document
42 Acceptance Test Specification
B (Software) Configuration Management Plan
+-_1] Detailed Design Document
Design and Developrnent Plan
Project History Docurnent
Product Requirements Document
Cluality &ssurance Plan
Risk Management Plan
systern Reguirements Document
software Transfer Docurment
Software Developrnent History Docurment
Software Project Management Plan
iSoftware) User Manual
User Meeds Docurnent
Yerification and Validation Plan
software Project Management Plan

M= MM T e

(I (T3 (T3 (TP (P9 (FOE9 (129 [TO29 (120 [TR20 [TER (TR [T

[

El

(0]4 | Cancel |
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KAIST

= Formal module based on template(cont’'d)
— Result of creating a formal module based on template

Formal module(4/4)

E Formal module */DC_lI/Template module’ current 0.0 - DOORS

File Edit Wiew Insert Link Analysis Table Tools User Change Management TaAU  Help

HESE % meo v

=

=4

| Standard view

| |&lllevels || 35

¥EFE GO

TEEYTF UL A B

= Template module

+- 1 Introduction

+- 2 Project Organization

+- 3 Managerial Process

+- 4 Technical Process

- 5 Workpackages, Schedule
5.1 Workpackages
5.2 Dependencies
5.3 Resource Requiremn:
5.4 Budget and Resourc
5.5 Schedule

0]

D Ein

Username: thsong

1 | 1 Introduction

2 | 1.1 Project Overview
3 | 1.2 Project Deliverables
4 | 1.3 Evolution of the Design and Development Plan

5 | 1.4 Reference Materials

= | 1.5 Definitions and Acronyms

7 | 2 Project Organization

8 | 2.1 Process Model

9 | 2.2 Organizational Structure

10 | 2.3 Organizational Boundaries and Interfaces

11 | 2.4 Project Responsibilities

2 | 3 Managerial Process

13 | 3.1 Management Objectives and Priorities

14 | 2 2 Acaimntione Nanondoncioc and Fanchraintc

Exclusive edit mode

I o

Software Procass Improvement Ganter
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KAIST =
Formal module(7/7)

= Displayed information

“No change since baseline”
Baseline, change-bar (green)

Heading object
k£ AR 2 M / H|

Object number

1D
Object identifier 1"CVM Requirements Llink indicator
\E 1.1 Coffee Requirements J

3 |HT A= 22, SIS HIZET "

;E”ﬁﬂlﬂﬂé HI2HE 2 S HE 20| S0{2ICH "

/ “Changed since baseline,\
change-bar, saved (yellow) :
“Changed this Text object
session”,
change-bar,

unsaved (red) “Change-bar”
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KAIST =
Objects concepts

= Formal module are collections of objects

— Object may be used for :
* Requirement text, Headings, Graphics
» Other information(hyperlinks, OLES)
— Heading objects
* Providing context for the requirements (or other objects) below them
« Section number (Object number) is displayed
— Text objects
« Contain requirements, graphics, other text
* Should be leaf objects in the module hierarchy

11 CVM Requirements : :
Heading object
2 1.1 Coffee Requirements

3 AT AED|s EUAHI, LTS HIZECL [ Text object ]
|

“Make text objects children of the heading object”
“Don’t make text objects children of other text object”

2007-03-22 23/68



KAIST o [
Object(1/5)

= Create object
— Insert =2 Object or New Object at this level icon click

B Formal module '/Bequirements of CYM/CYM Requirements® current 0.0 - D... x

File Edit Mew | Jgsept Link Analysis  Table Tools User Change Managamant Tall  Help

H &S Object = i
|Standard view o L “s £ [ 7w &l | o
Calumn,.,.
CUM 22 AR 2 M [~
aymbal,,,
Picture, .,
Template,.,

Insert a new object,

2007-03-22 KAIST SELAB 24/68



KAIST

= Edit object heading

Object(2/5)

— Edit 2 In-Place - Edit Heading or Edit Object Heading icon or

Double click

File Edit Miew Insert Link  Analys

E Formal module ‘YBequirements of CYM/CYM Bequirements® current 0.0 - D... !EH

i ble
=k,

Tools  Udser Change Management Tal  Help

= Ve B 7 U | (= iE £ 59 & E. O

Star Cut Cipl+s els || J&c e R W OF AN

= Copy * HD CWM 22 A2 M [~
111

Find... Cirl+F
Beplace, .,
Go Ta,., Ctrl+5

Columns, ..
aitributes, |,
Tvpes...

| NN \
Type “CVM Requirements”

Usernare: siwoo Exciuziwe:

IDouble-Click

2007-03-22
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KAIST J2c

Object(3/5)

= Create object below
— Insert =2 Object Below or New Object Below icon click

E Formal module ‘/Requirements of CYM/CVYM Bequirements® current 0.0 - DO... 5 [=] ks
Eile Edit Wiew| Ingert Link Analysis  Thble Tools User Change Manage Tall  Help
E % g % Dhjnﬁi‘ [ 1 | " i: 8 :‘; i‘\ D
Object Belowe Ctrl+L —
Standard view | =E=E=E= £ B THF Al | oy |
_ Colurnn, ,,
= CVM Requirery CYM 22 AR document [~
- 1 C¥M Req Syrbal... -
L1 Picture, .. 1 CVM Requirements
Template.., !ﬁ | E—— i
I \\d«
(13 - » N
Type “Coffee Requirements Ny \
Double-Click
< ﬂJ
Username: sjwoo Exclusive edit mode

2007-03-22 KAIST SELAB 26/68



KAIST IFae
Object(4/5)

= Edit object text

— 1. Create object below

— 2. Edit 2 In-Place =2 Edit Text or Edit Object Text icon or
Double click

E Formal module "/Requirements of CYM/CYM Requirements” current 0.0 = I [m] [
File] Edit Aiew Insert Link Apalysis m Tools User Change Management TaLU  Help
d v co =l s g B E|
5 cu Crivx Jols =] e b = === € E 74l |~ B W]
Copy r =]
= B | cvm 27243t 2.4
1| 1 C¥M Requirements
5 .
Find... CuleF 1.1 Coffee Requirements
Feplace,,, 3 |ATAED = E8AHO 22, 23IHLE HISETCL >
Go To,,, C1rl+E — e
Columns...
Aftributes,
Tvpes..
[Cbio-t 3
Farge Sil
, Edit Haading Ctrl+H
Section - ——————
Edit Text Ctrl+T
N I3 T | _>ILI
Username: train0l |Exclusive edit mode
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KAIST
Object(5/5)

= Create new object text
— While editing object, use “Ctrl + Enter” to a create a new Text

object at the same level

E Formal module "/Requirements of CY¥M/CYM Hequirements" current 0.0 =1 101 =l
File Edit Miew Insert Link Analvsis Table Tools User Change Management TalU  Help
EE | FEFFL(E ¢ ocE|

HEE »B@B|(Y X . =B 7Uas|Ez=
- [fEVH e B

||Standard view L”I'e‘” levels L” L | =E==E =
= CWM Requirernents 5= ;I
21 C¥M Requirements CvM S-ArEr 24
=- 1.1 Coffee Requirements | 1 CWYM ReqUirements

AR = 2]

RN .
| 1.1 Coffee Requirements
H| TEIT ] — %:HWI MQ‘:HWI DIEZHWIE E;H_L

o e o4

[Username: raindi |[Exclusive edit mode

28/68
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m Software Procass Imgrovemant Gantar

g Exercise #1

= Develop the CVM requirement

Formal module name : “CVM requirement_ID”
* Ex. CVM requirement_kayoon

Make object and text

= C%M Requirements 5F =
=1 CWh Requirements D |C‘¢'M 22N =N
- 1.1 Coffee Requirements 1 1 CVyM Requirements

AHI A= EHA
EHALIN = HLIHE

HET|HE HIT D+ 2 1.1 Coffee Requirements
AL HEE ) R _ L i _—
SHMAL FHE I 3 HIO AR = S}HHIO, 2FALE HEETC
SEAHL T 21 _ _ - -
21,2 Change Requiremen 4 EVHIMH= HL?=E2 =HZE 0| EHAICL
AHI ME= 510 — = o =
F2ls W S | 5 SEHIN= HILZIE, =4z 2, €501 SHZUCL
108 Y0 AL = = = eSS =— ==
B2lE 9 HEMNT) | & HOILAIESE I ZHED| 2HHH EHE £, €2, HI?E =22 ESECL

2S LT HEMNT
I = 7SI BT D12 SEOIC

5 2= EEE 22 10 0IC

9 1.2 Change Requirements

10 HIO AR =5, 108 ER2] EFHEE AT/ Mok S

11 SEE P10 SHAL HES F=28H SHALIHIZZCH

12 10EE YD EHHIHES FEASHE HAE =2 EHAHIP HISTEIC
13 SEEPD 4L HEES +=0 sH0| BrEEICH

14 10EEE0 2EHI HEE 728 I HISECH
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KAIST Iae
Links and traceability(1/10)

= Link
Relationship between two objects is established by “Link”
Source Object is "from” object
Target Objects is "to” object

CWi BFAE 2 i
1 CVM Requirements

1.1 Coffee Requirements

ALl AHE = SO, £EHLE HISECL

SMHIH = HILZIFE £H=E 20| SHIHCHL

SAHLIH= ALV R, =Mz E, 220 SHIHCL

D0 HIZE 0 THID| 2 SSHS 8, 4S8 30 £02 Z3Ect
3T S50 92 sRlCk Source object

=
SAHL EFErE 212 10 0ICE

i

d

Wz § i

? Change Requirements
Ao A =5 10 e =T A TIHOEFECE

L~

SHE §I SHI HES F2H S35t HIZTCL Target object
1092 §D SUHI BES F20 52 HAS S0 SUAHLIHIBECH

SHE 9D 530 HES T2 sH| S

10992 90 BEHI HES T2 SFHII ABED
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KAIST
Links and traceability(2/10)

= Why define relationships?

— Requirements in any real project are inter-related
* These relationships can be used to understand dependencies
between requirements and assess impact of change
— Requirements also have relationships to other artifacts for the

lifecycle
— “Maintain bi-directional traceability among the requirements and
the project plans and work products” [CMMI v1.02]

2007-03-22 KAIST SELAB 31/68



KAIST Iae
Links and traceability(3/10)

= Two kinds of methods for creating links
— Drag and drop linking
— Menu-driven linking

Drag and drop Menu-driven linking
——— r— ‘ ——— | ‘ ——

1:1 1: N

2007-03-22 KAIST SELAB 32/68



KAIST Iae
Links and traceability(4/10)

= Drag and drop linking

B Formal module '‘/Requirements of CVM/CV¥M Bequirements’ current 0.0 - DOORS

File Edit Miew Insert Link Analysis Table Tools User Change Management TaU  Help

HEE s e ¥ = =, =l Nll=

|Standard view | Al levels + ]| 3 e gl YW Wgﬁaﬁj.eéﬂ W Iy

- WM Requirements 5h o= j
= 1 WM Requirements g Ol By =

21,1 Coffee Requirernents 11 CVM Requirements
Hil| AHIH | = A
EHALHE AHIIHE

HEHTHE HIIH 2 1.1 Coffee Requirements
2t S [ A _
ot AR Tt 3 T AIEDIE SHHT, ST AZEh

SEFHI g 21
—- 1,2 Change Requirermen
HI| A= b, 103

4 AN = AHL?IFZ LCHE 20| EHZUCL
ERS WD) HHMA | 3
=]

FHINE HLXNE, =AHE 8, €0 SHCH

TI2ERIZE 0 AR 2MA M= 2, 23 HIIE =22 SSE Drag & Drop

i SO S

7 =MAm hEE| 2= sE=0|CE
sy

% 1.2 Change Requirements

o ot e ) \@\
J
-

T v e P T e =g L =2 = = i

11 SHE HU SMHIIHEES =23 SH;HAHLHIZEICH

12 107E 30 SO0 Hes T2 500 Ars =of SAALT A= aLk | h 4
13 SHE YD SN HEES F2H 570| BHHEICH | Make Link From Start
14 102S 9D LI WES F23 LTI MBS
bove »
y sjwoo ol 4 | N Lopy y
Delete the currently selected ohject, CDD'—'-" then link '
Cancel
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Links and traceability(5/10)

= Result of creating link

E Formal module '/Requirements of CYM/CYM Requirements' current 0.0 - DOORS

File Edit View Insert Link Analysis Tahle Tools User Change Management Tal  Help

HEE & B v =t 5. EE - Nl
| Standard view | |Allevels =] 34 BT 2o~ B
= CWM Requirements CyM B2 E2M E|

= 1 Cil Requirements

= 1.1 Coffee Requirements | 1 CWYM Requirements
AL A = 8
EEH Y77 = m £
ggéj ﬁlﬂjlg ;%Bt 1.1 Coffee Requirements
ALV HSE I A N
=) fs_r??rﬂ Jt= | HI A= E¥AHI, 2EHLE HISEC

EFHI| 5HA2| J1A

BN FHEE] U Sk

-- 1,2 Change Requiremen SHAMM = ALIF2 £ HF 20
DS R T8 | sesimns HI01E, ©HE 2, 220 SHa,
RS LA | AT HIZE o A ShilA SR B, 2T, AT 22 T30
A& S #8AN | zazym srzre) 21212 s2oiCk

=
[
i
i
]
LS
1
=
El

= T out-ink
ST &Rl IS w0l
1.2 Change Requirements
1 KHID = 5, 108 W2] SHOH AHBEIHOF Bhct,
SHE G0 B9 HEE T2 ERHT I MBS0
0HE 0 S8HI HEE F2H s HAS =0 SHHT I MIBEC 1in-link

Username: sjwoo Exclusive edit mode

I o

Software Procass Improvement Ganter
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= Menu driven linking

I o

Software Process Imorovemant Gantar

Links and traceability(6/10)

Use Tool bar or Mouse right button

E§ Formal module ‘/Requirements of CYM/CV}. Requirements’ current 0.0 - DOORS

File Edit Miew [ns o=t .- o e Change Managerment Tal  Help
HEE & Sanbink = HE D

4

|Standard view

= C¥h Requirements
—- 1 CW& Requirement:
—- 1,1 Coffee Requir
AL A =

Create Links...
Link by Aftribute. ..

EHATHE Delete Links,,,

HEFATHE  Delete All Links...
o HEE

Q;H' ;Jmﬂgﬁ New External Link
EfAHO FhE

Delete &ll External

E2l= 9] Ei_w!idillLink‘S...

Ly

i EEY W Delete object @ w

d

quirements

lequirements
AL, YEHIIE HIESECH

L2IE2 = HF 20| EHCH
U2z, £Hz 8, 2%

HOZHRHIEE W AH0D] QA S

Links. ..

=)
i
=)
i
o

10
11
12
13
14

—
S3AW T2 2= SE0ICH
=

NI E=A N s e e PN

i

1.2 Change Requirements

atart Link

ALl A2 = 5, 103 2| SET AMSZIHOF &L

K —

24

Delete the currently selected object,

Delete

Submit Change Proposal,,,

-
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Links and traceability(7/10)

= Menu driven linking (cont’'d) _
,Use Tool bar or Mouse right button

E§ Formal module '/Requirements of CYM/CVYM Requireme s’ current 0.0 - DOORS
File Edit Mew Insert Link Analysis Table Tools LUser ange Management TaAl  Help

HESE % Start Link Cr+l 5 B ' B || @
- CresTStaT =
|Standard view Make Link from Start P BT Dokt objecy & B
= kA Hequiremgnts Tieal Lk j
—- 1 CW& Requirements : )
1,1 Cotiee Requin  Link by Afribute. . |uirements

AL A = .

SEATH nE|ET€ Links.,. .

HERMHE :  Delete Al Links.,.. equirements

HI 7 _ I

= stek New External Link 43I, 4=HLE HISEC

HEO R = o =

21,2 Change Requ  Delete All External Links. .. JIEZEHE 201 EMHCH

AL M E s = =2 MEn| =EH7

cos o = EditLinks.. JHE, EHE E, 220 SHZICL

1A S =1 SHA o ) T o S 2 MEr H OIS oz 2o

BEE W0 SET | 6 HIZPFHISE i ZAHED] 2l EHE 8, 4, HIPIRE &22 ESEC

1S 20 2830 7 SHI e JFE2 sAEDICE
B SEAm EEe] 212 1Rolct v
3 1.2 Change Requirements start Link
10T AHIR = 5 qneimle | RO ALE S| S} Clear Start
11 SEEF1 EHRHII HEE T20 SHAL> HMSEICH Malke Link from Start
12 1I00E S0 =971 HEE redond A2 s =4 SAAL0T Maac. ,

I _ o - ) Mew External Link
13 5®EE HD dEHI HESE F=H sHO| YHEHEICH
14 1WHE YD LEHI HES 720 2HIP HIZECH
K I— 24 | ,
Delete the currently selected object,
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Links and traceability(8/10)

= DOORS Links module

E DOORS Database: /Requirements of CVM - DOORS - I:II xl

File Edit Miew Favorites Tools SYMERGY/Change Integration Tal  Help
EEAs & BE BE D B

Faunrites:| LI Location: |,J’Fiequirements of CWh R
Elr% DOORS Database Mame | Type | Descriptior
=1 Coffee’endingMachine eleid-Requrerments Fara St
‘&l Requirements of C\f G DO0RS Links Link Link modu
1 Company project

w21 DC-Integration
-1 DOCRSExercize

------ [ TelelogicExercise

o | o Ll | o

. |Username: sjwoo User type: Database Manager | Y

I o

Software Process Imorovemant Gantar

B\

Double click
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Links and traceability(9/10)

= View DOORS Link module

E Link module ‘YRequirements of CYM/DO0ORS Links' current 0.0 - DOORS x
File Edit Miew Tools Help
= [Mo linkset selected |
[T e Lelee ot —cloctod |

> a

< r Select
4l | ﬂJ
Username: sjwao Exclusive edit mode Source: Target:

KAIST SELAB 38/68
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Links and traceability(10/10)

= View DOORS Link module (cont’'d)

E Link module '/Requirements of CYM/DOORS Links' current 0.0 - DOORS

File Edit

Yiew Tools

Help

= |/Requirements of CYM/CYM Reguirements > /Requirements of CYM/CYM ~|

S flsa

i.i-1

/Requirements of CYM/CVM Requirements

Kl

Username: sjwon

/Requirements of CWM/C¥M Requirements
1.1-6
SEHHO TS| D 2230 THEE O
1.2
Change Requirements
1.2-1
AL AHE| =5, 10H

HLIHHE2 I AT
1.13
SEA MM = It

SHALH = ALt

1.2-5
Hil AHEI = S 10#E 10 23| AT

HI AHED = S HH

SHALH = HILITt

SEFLHE ALt

AL HIZE [ AR

SEAHL T2
Change Requirements
AL AED| =5, 10

&S 21 S

o
T

N

|

Exclusive edit mode |Source: CWM Requirements Target: C¥h Requirements

I o

Software Process Imorovemant Gantar

Represent link
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Exercise #2(1/2)

= Create links in requirement

- Link guideline

Requirements

Traceability table

I o

Software Procass Improvemant Canter

IC ] CyM B2AKZH =M

1 12 |3 10 |11 |12 |13 |14 target

! 1 CVM Requirements )
2 1.1 Coffee Requirements 5
3 AL AHED = E3AHL, 2HLE HESTCH 3
4 SHIMH= HILPIFE EHZ S0 SHUCH 4
5 HEHIH= HIMNE, ZHE 8, 420 EHCH
6 HIPHHZSE o ZED 2tlld =HE B, 85 HIHE === Z3ECH >
7 2T FHT JHE2 sR0ICH 6
8 LTI &Fe| 2= 1w020Ich 7
9 1.2 Change Requirements 8
10 AL A= 5, 102 SEHI AFZEI MOk 31T 9
11 SEE YD SHHI HEE T2 S/HIILAISECH 10
12 1W0HE S EHHI HES F2H SHY HAZ EU SMHHIOLHISEIC 11
13 SHEE P10 421 HEE +2H s#0| BHEEICH 12
14 1WHEFD LEHI HES T2 LEHI2LAHISECH 13

14

source
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= Result

E Formal module "/Requirements of CYM/CYM Requirements’ current 0.0 - DOORS
File Edit Miew Insert Link Analysis Table Tools User Change Management Tal  Help

HEE 2o v

== LI

|Standard view

x| Al levels =] 34

P EH VW TR w | BW

- CWh Requirements
- 1 CWh Requirerments
- 1.1 Coffee Requirements
Hil AFE = S
EHAHLN = HLIIH
SEHIH = HIJH
AL HZE M AT
SHHI 22 JHEE
SENI FHE I
- 1.2 Change HeqU|remen

K — i

Username: sjwoo

CyM B2AFZH 2 M

1 CVM Requirements

1.1 Coffee Requirements

HI I = E¥HI, fEHIE HISEC

SHAMMN = HIZIFEL £ HE S0| EHZICL

HEATH = HIHF, =HE 8, 20l EM2Ch

HI2H HISE i FHDD) 2HHlH =HE 8, 22, HIDIR =22 258
WHI TS| =2 s2I0ICH

S I EhErE 2FEE 10R0ICk

Ll IUIH

.2 Change Requirements

.
=

| AFE2 = 5, 10| SEIEAREEIHOE S

SEHE Y10 S¥AHI HES FE28 SHAHLIHHISECL
HE HAZE = SHAHATIHIZECE

SEHE ¥ 2FHul HEE F2H s 0| FEEIC

3
Flt
o
LN
=l
N
JI’U
&
=l
Es
rlm
i
qr
1]
g
n

Kl

Exclusive edit mode

I o

Software Procass Improvement Ganter
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Shareable edit mode(1/5)

= Concepts of shareable edit mode
— It is often necessary for more than one person to edit the same
formal module at the same time

* Multiple users may edit different sections of the same module at the
same time
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I o

Software Procass Improvement Ganter

Shareable edit mode(2/5)

= Setup for sharing(User : sjwo0)
— In exclusive edit mode : Tools = Setup for Sharing

E Formal module ‘/Requirements of CYM/CVM Requirements’ current 0.0 - DOORS

File Edit Miew Insert Link Analysis Table | Tools User Change Management TaU  Help
HEeE $ao ¥ = =,| Fier rEE O
Sort,,,
|Standard view x| ||alllevels »]| 3u Zpelling,.. Oyl LB 2l | B W
=- CWM Requirernents .
+- 1 C¥M Reguirernents o G Fglnctmns i’
1 1 Wizards 4
Support Tools 4
2 1 Refresh DL Attributes
Lompare Maodules,,,
EREN | Setup for Sharing, ., .
4 =3 yug
S 2% Test Tracking » EHZIC
6 AHI  EditDxL... 22 ALVIRE =22 S=T0
7 = DL Library, .
& EFHIO EEE 2EE w0 0lch
9 1.2 Change Requirements
10 HI AHED (=5, 0B AR SHOE AFEZI0F S
11 SEE J1 AL HES T28 AL HISECH
12 10EE FD EHAHI HES T2 SHEY HAE T EHAHIOHHISECH
13 SEE 91 SAHI H=EE T20 s20| SHEEICE
14 1WEE PN LFHI HES F=2H SFAHIYAISECH
Create sections in the current module,

E Setup for Sharing - DOORS

Ferforrmance may degrade if you make lots of editable sections,
Select the smallest nurmber that meets vour needs,

Make editable sections at level: |1 -

Cancel | Help

Every object below 3 level (3,4,..) is shared

o]
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= Open module in shareable edit mode(User : sjwo0)

E DOORS Database: /Requirements of CVM - DOORS =l

Shareable edit mode(3/5)

File Edit “iew Favorites Tools SYMERGY/Change Imtegration TalU  Help
= LRI b

I o

Software Process Imorovemant Gantar

Favarites: | _Ll Location: HiEEMERER ﬂ
= DOORS Database Mame | Type | Description
+-(C3 011z.DC ps M Requirernents H
+ % 0306_test EPDOORS Link Link madule created autornatic,
¥ 20070104 R
+ D BaCkUD '_:_ ‘eahle Edit
--(Z] Coffeevendingtachine Cut Il Els S
&5 Requirements of CWI Copy =
+-[[1 CoffeeVendinghachine. Copy URL
1 Coffee¥endinghachine.
+-[@ Company project
+ CyM _kayoon_1
+-] CWM_kayoon_2
+-(DCI Delete
+-[_] DC_Integration
+-_7 DCIl Properties, .,
+-[_] DC-Integration
+-([1 DOORSExercise TAU ‘
+-[_] RCRexer
[ TelelogicExercise
-
‘| | wi 2]
Open the selected module for shareable edit,
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Shareable edit mode(4/5)

= Multi user section locking(User : sjwo0)

ID |CuM 2P ME ZA
1 1 CVM Requirements \QGS\\
e < \
2 1.1 Coffee Requiremer “'Tnse + , N
T AL e =L =2l Link N . .
4 SUATLHE HDIEL CHE nght-C“Ck
5 LSAEATONT, €oi2t Copv g — W A BN ]
= 0
6 FATIEAIZE 0 AT Sl 23 I 1 CVM Requirements
7 SHH @ SRRl 2HEE sE0ICH

=
8 ZSEFI & 3E= 10-H0|C

I o

Software Procass Improvemant Canter

Submit Change Proposal, .. 2 1.1 Coffee Requirements
9 1.2 Change Requireme  Froperies... 2 A A= SHAHL, SEHIE HISET
10 HI A= 5, 102 W2 S5 4 EHAHTHE=E HDEZELE EHE 20| SEHZCH
11 SREE YD EMHI HEE 5+ 5 HEAHTHE HIE, ©HE S, D20 EHZHL
1o 10912 9D SMHT HES = HZE 6 FALILAISE 0 AHID| B 32 8, £, A= 222 B39t
12 SREE YD I HEE F2  TaU ’ 7 ST =tEtel 212 sEDIC
I 8 SR 817l 212 wolch

2 1.2 Change Requirements

10 HI A2 = 5, 108 2| SE 2 ALETIH0F 5T
11 SRE E1D M0 HES 23 SHHLP HISECK

12 109291 S HES $20 58 HAS S0 SOt HIBECH

L= L= — . L = [ T N et W1
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Shareable edit mode(5/5)

= Multi user section locking(cont’'d)
— Result of shareable edit mode

[User . Sjw00 ] [User . thsong ]

D | CWM SAE 2N E D | Cy 232AFEF 2M
1 1 CVM Requirements ! 1 CVM Requirements
2 1.1 Coffee Reguirements 2 1.1 Coffee Requirements
3 Ao R = M, SEHILE HISET et N 3 AL AHD = S3AHI, S2HIIE HISECL
e i N e g e e g a3 Link , e 1 1y e 1[0 i el ) Link ’_I
5 2EAOM= ALPIE, A2 &, 280| SHICH 5 Z2FHOH= HL2HF, EHE 8 S50 SH2ACH
6 FHIJHHIBE W AW QUM EHE B, B, HIDIR 4 Cony > 6 M7t AIBE W AHED| SHHlH SHE B, 25, HI7E  Con >
Copy URL
DOORS
Submit Change Proposal,,,
Q section lock failed: tem /Requiremel  puoperes. . terments locked (unshared) by thsong@SE-227BYIA0AEEE at 0313407 21:09:55
.
Tal v
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Additional object information(1/4)

= Capturing additional information via attribute
— By using and displaying attributes and columns

= Attributes

— Additional defined characteristics of an object
» Source : Who specified this requirement?
* Priority : What is the priority of this requirement?
« Comments : Any comments on the requirement to clarify its meaning
* Questions : Any questions that must be clarified with the source
— Attributes make requirements to be more effectively and efficiently,
use them to

 Filtering

« Searching

« Sorting
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Additional object information(2/4)

= Attributes(cont’d)

— Classification by attribute definer
 DOORS-predefined attributes
— EX) created by(by DOORS), Object heading(by users)
« User-defined attributes
— Have specific meaning for a project
— Will support your process
— EX) comments, verification method etc.
— Classification by target
* Object attribute
* Module attribute
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Additional object information(3/4)

= Edit attribute

E Formal module '‘/Requirements of CYM/CYM Requirements’ current 0.0 - DOORS

Edit attributes in current module,

Fila iew Insert Link Analysis  Table Tools User Change Management Tall Help
= |V == (D
Star Gl Crbed - Rels = e TEEYTF S B
——  Copy r
-G CVM 8 2AE 2 M
1 CVM Requirements
Find... cusf | 1.1 Coffee Requirements
Find Next — F3 A1 AHIDIE SUHT, LTS HIB
Beplace, .,
Go To.., chl+G  (EEATLNIE HI2IER X2 20| EHCH
TSN LSO H= HI2HR, =HE E, HEo] EHZHC
Attribut L2t HIZSE 0 AHD| 2 =HE E§, 48, HIE 222 E2E0H
F
) SWHAI FHEE] IFE 2 s/0|CH
Ohject 2 .
In-Flace v |ZSEAHT EHEE] 2122 102 0ICH
Furge &l 1.2 Change Requirements
Section Y AT FHERIE 5, 10 Ae] SHOE ARZCIHOF S
Edit Mode 2

T5EE S0 EYAHI HEE 28 AL HEEICH

10¥E 91 ST HES T2 ST HAS E0 SUHIH HIBCH

I o

Software Procass Improvement Ganter
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Additional object information(4/4)

= Default attribute of column

Columns | Attributes l Types ]

E /Requirements of CYM/CVM Requirements:Object 10 Columns and Aﬂribute...!EH

[/Requirements of CYM/CYM Requirements:Object 10 Columns and &ftribu

I o

Software Procass Improvement Ganter

We need "priority”
attribute

Mame | Tupe [ Default value [ Tnheri value [ EXists for [ T valued |

Absolute Number  Integer Mo Object Mo
Created By String Mo Module & Ob,,, No
Created On Date Mo todule & Ob,,, Mo
Created Thru Created Thru Manual Input Mo Object Mo
Description String Mo Module Mo
Last Modified By String Mo Module & Ob,,, No
Last Modified On Date Mo Module & Ob,,, Mo
Marme String Mo Module Mo
Object Heading String Mo Object Mo
Object Short Text  String Mo Object Mo
Object Text Text Mo Object Mo
Prefix String Mo Module Mo

MNewy,,, || Impaort,., |

Close | Help

= From now on, we will create "priority” attribute to present
the priority of each requirement
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KAIST J2c

Software Process Imorovemant Gantar

Creation of new column type(1/3)

= Create new type(Ordinal) of column

E /Requirements of CYM/CVYM Bequirements:Object 10 Columns and A.ttrihute...!EE

Cnlumns] atributesf 1

Marme Base type | Min I & New Tm e
Boalean Enurneration Type name: [Ordinal |
Created Thru Enurneration B , ——_—
ase type! [ETE e [
Date Date
Imteger Imteger nurmeratians |
Real Real Access Rights
String String =
Text Text
User name Username Marne | Access rights

Access rights for thsong: RMCDA

>
0Ok | Cancel| Help |
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Creation of new column type(2/3)

= Create new type(Ordinal) of column(cont’'d)

Type name: [Ordinal

Base type: |Enumeration |

dccesd Enumerations

E New Type - DOORS x|

Value: |Low

Felated number: |1

Use color
= Default & Specified

Add >

Caolor

_|Light_Blue2
__|Light_Blue
[Dark_Turguoize
__|pink
e
Wlt4araon

[ [3El
_|wellow

[l Green
[]cyan

Bl tagenta

nnnnn

7

Walue

| Related num

WHish 5

Mediurm 3
_|

PlLow 1

nol

0k, | Cancel |

Help ‘

 Value : High, Medium, Low
* Related number : 5, 3,1

» Use color : default, specified
» Add click
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Creation of new column type(3/3)

= Create new type(priority) of column(cont’d)

E /Requirements of CYM/CYM Requirements:Object 3 Columns and Attribute. .. !EE

Date

String
Teut
Iser name

Date

String
Teut
sernamme

Cnlumns] Attributef  Tvpes ]
Mame | Base type | Min value | Max value
Boolean Enumeration
Created Thru Enurmeration

Mew, ” Impaort,., Copy,.. |

Close

‘ Help |

I o

Software Process Imorovemant Gantar
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Creation of new attribute(1/6)

= Create new attribute(priority) of column

E /Requirements of CYM/CYM Bequirements:Object 10 Columns and Hﬂrihule...!HE

I o

Software Procass Improvement Ganter

Caolurmn I ypes]

Mame | Type | Default value | Inherit
&bgolute Murmber  Integer Mo
Created By String Mo
Created On Date Mo
Created Thru Created Thru Manual Input Mo
Description =tring Mo
Last Modified By String Mo
Last Modified On Date Mo
Marme String Mo
Object Heading String Mo
Object Short Text =tring Mo
Object Text Text Mo
Frefix String Mo

Mew,,, Impart,,,

E New Atiribute - DOORS

CGararal |

TAT N

5 |

(i o
I

Marne: [Friorty

Type:

| qeale &2

N

=S

[~ DL aftribute
[~ Multi-valued

[~ Default value:

[v &dd nesw attribute to current view

Exists for:
[v Objects

[~ Module

Attribute should:
[~ Inherit value

v &ffect change bars

v Affect change dates

v Generate history

Cancal Healp
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KAIST I=C
Creation of new attribute(2/6)

= Create new attribute(priority) of column(cont’d)

E /Bequirements of CYM/CYM Bequirements:Object 3 Columns and Attribute. .. HEE

Columns .":".ﬁritlthESl ':.-'I:'ES]

Marmne | Type | Default value | Inherit value | Exists for | Multi valued |
Sbsolute Mumber  Integer Mo Ohject Mo
Created By String Mo Module & 0Ob,,, Mo
Created On Date Mo Fodule & Ob,,, No
Created Thru Created Thru banual Input Mo Ohject Mo
Description String Mo Module Mo
Last Modified By String Mo Module & Ob,,, Mo
Last Modified On Date Mo Module & Ob,,, Mo
Marme String Mo Module Mo
Cbject Heading atring Mo Object Mo
Object Short Text  String Mo Object Mo
Object Text Text Mo Ohject Mo

H C"“‘ hIHA | Il

Mew,,, ” Irmport, ., Copy,., Delete | Cdit, ., |

Cloge | Help |
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Creation of new attribute(3/6)

= |nserting a column of priority

Aﬁrihutes] Types]

uirements of CYM/CVM Requirements:Object 10 Columns and Atir... !EE

Title

| Attribute

| Type

[
CWM BE2AFE =M

<0bject |dentifier:
<0bject Heading & Object .,

I o

Software Process Imorovemant Gantar

Close | Help

£ New Column - DOORS x|

Contents

& Aribute |Object Level

Created Thru
Last Modified By
Last Modified On
Chject Headin
Object Short Text

" Layout DL
"~ Ohject Heading

Tewut Color

e Default

= By aftribute |

Column Title: |

I )8 I Apply | Close |

Help |
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KAIST I=C
Creation of new attribute(4/6)

= |nserting a column of priority(cont’d)

E /Bequirements of CYM/CYM Bequirements:Object 3 Columns and Attribute. .. !EH

Columns | &ttributes | Types |

Title | Attribute | Type |
0 <Object Identifier:
o oL o a0

Priority Ordinal

MNew,,, I Copy,.. | Hemwel Edit,., |

I Close |I Help |
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Creation of new attribute(5/6)

= Edit priority attribute

— Click or Edit > Object = Properties = Attributes - Select
attribute - Edit

E Formal module '/Requirements of CYM/CVM Requirements’ current 0.0 - DOORS

File Edit Miew Insert Link Analysis Table Tools User Change Management Tal  Help

CEFIRE TR == L=
[Standard view | |[AlNTevels ~] | 3uc rEEH YV 2l | B
= CWM Requirements CWM 2 AREE 2N 31 Priority -

- 1 CW¥M Requirements
= 1.1 Coffee Requirement: | 1 CWVM Requirements

ST T = 25
EEE:H; %I SHE 3%}3{ 1.1 Coffee Requirements
S FHE| JF R P i =t B e | At
1.2 Change Requirem SEMHHIH= HIZFEL CHE 20| SHIICH
O B =i L i o == E=T w3
SE T UHIH SHE 8, 48 HIDHE === E3ECh
=252 0ICHL
2 108 0ICh

E

5els g0 geoi) | | THOHA
R

=
=
LEHI EFEE] 2F

W IN

1.2 Change Requirements Feset to Default
AHI AHYD | =5, 102l S 32 AFZEIHOF S L

SEE F1 EYHIIHEES F28 SHHU HISECH

10EE P10 2FAHI HES ¥23 AL HSE L

PY— S L

Username: sjwoo Exclusive edit mode
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= View completion of priority attribute

Creation of new attribute(6/6)

I o

Software Procass Improvemant Canter

Cy 2AAEZFEM 3| Priority
1 CVM Requirements
1.1 Coffee Requirements
HIl AHE = SBAI, 2EHTE MIZECH * High
SEHALN = ATLIIF2 HZ 0| SHICH ¥ Medium
HEHL W= HLME, EHE 2, ZE0] EH2UCH ¥ High
HI2HHIZE W A2 2HHIA SHZE 2, 22 HLMF =22 EgEI0 Medium
SHI| BT 21 S sROICH * Low
SEAT BT 212 w0 0Ict ¥ Low
1.2 Change Requirements
HI| A2 =5, 0% B2 SH2E AMEZ[HOF S0 ¥ High
SHE P10 SHAHL HES F2H SHAHL2HHIEECH Low
W0HZE A0 EHHI UEE F2EHSHD 2|28 =4 23FHL?| Al SEC. Medium
SH=E F0 220 HES +2W 50| ZHEEICH Medium
W0HE Y0 I HES 20 SZFHI2HHI ST Medium
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Finding and displaying the data(1/3)

= Filtering attribute

File

Edit Miew [Insert Link Analysis Tab

B Formal module ‘/Requirements of CYM/CVYM Requirements' current 0.0 - DOORS

I o

Software Process Imorovemant Gantar

(== & g =5
| Priority x| |alllevels v || Suc =201
- CYM Fequl t = spelling, ., Crl+k, —
+- 1 CSEdugee;nueirneiwents M B J H|F‘rl0r|ty J
1CVMF Functions »
1.1 Coffer  Wizards E Filtering: 'YRequirements of CYM/CVYM Requirements' - DOORS !EE
= . Support Tod X —
AT A= Refrash D Attributes lLinks | Gibjects | Columns | h Stanshlu:s
1 otal Objects:
ot Compare M I | Priority -
HEHIHI= EE“-ID far SH ﬁEEEDtEd: l—
AT7HRIZE lis equal to - .
ST 57 | = Rejected:
=ToE e High -
AL e Test Track —
I
L20hane g v Match Case [
HI A= DXL Library
SEE 9D EUFI HEES 28
IDUE 9D SMHMHES +2
5SS 9D S HES 28
WOHE J10 42HI HEE 72
4 Refresh ddvanced ] Spply Close Help
Username: sjwoo Exclusive edit mode
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KAIST ===
Finding and displaying the data(2/3)

= Sorting attribute

B Formal module ‘/Requirements of CYM/CVYM Requirements' current 0.0 - DOORS

File Edit Mew Insent Link Analysis Table Tools User Change Management Tal Help

CEEINE K =5

[Priority |||l levels v ]| Jud
S R T SR -
1 CVM I Functions 4
Wizards 4
1.1 Coffe  syuppart Tools r
Ho mimyls  Hefresh DL Aftributes £ Sort - DOORS !EE
SWHTH = Compare Modules,,,
e SR for Sharing,. sorfen: [prioriy gl IR Sort List |
ALIZHIZE lescending Priority
ot : Orfler: |Descending ~|} FRemove |
SHHL 2T Test Tracking
HEHI 5

Edit DL, ..
1.2 Chan_ D=L Library,..

AL FHYY = 5, 10 T2 SHI ARSI H 0k EHCH

SHE P10 Z2HI HEE T2H 57 0| REHEIC
Revert
10EE P10 S4EHI HESE F2H LEHLID A Q
Kl
Username: sjwoo Exclusive edit mode
‘ Spply | ‘ 0] Close | Help |
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Finding and displaying the data(3/3)

= Result
Filtering

ID CyM B2 AE 24 01 Priority
3 AHI AHY = E3A L, S2HIE HISETCH ¥ High
5 LEALIN= HIZE £H= =, 2201 SH ¥ High
10 AHI AHY =5, 0B R SHI AT MO St ¥ High
Sorting
ID | CuM A 2 A 0! Priority
3 0l AEDIE YA, 22HIE RIZEC * High
5 LENIHE ATOE, SHE 8, 2501 S0i2i ¥ High
10 HI AT 5, 10 AR SHI AFSEIOF S ¥ High
4 EVATNE AWIIZL =H2 S0/ SHIC ¥ Medium
6 FIIOHHIZE M AHED| Ol SHE B, 2T, HIOIE 222 B3ECH Medium
12 10W2 9D EUHI HES 20 582 HAF S0 AT} HISCH Medium
13 SHEE 90 LI HEES T2 sT0| HHEEIC Medium
14 10WE YD SSHI HES $2T SYHI2 AISEC Medium
7 EAM & 2R 2 sl ¥ Low
5 LI SEHE 2HE2 w00|ch ¥ Low
11 SHES YD WL HES F2H SHHWI MBI Low

I o

Software Procass Improvement Ganter
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KAIST =
Using baselines(1/5)

= Understanding baseline
— Baseline is a read-only version of a module

— It captures a moment in time and preserves it until you delete the
module

= Example of formal module timeline

Module created After 1st baseline After 2nd baseline  After 3rd baseline

modifications

L

modifications

3

3
=]
Q.
=
o
o
=1
=]
=
w

2]

c

=

=

1]

=

-

-

o

current 0.1

0O
c
—
-
1
3
—
-
>

current 0.0

Minor baseline 0.1 Major baseline 1.0 Minor baseline 1.1
(Read Only) (Read Only) (Read Only)
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KAIST =
Using baselines(2/5)

- .
= Creating new baselines — -

Existing baselines

- Flle 9 Basellne 9 NeW Baseline | Created By | Created On | Deleted By | Deleted On

E Formal module ‘/Requirements of CYM/CVYM Requirements’ current 0.0 - DOORS

File Edit Miew Insert Link Analysis Table Tools User Change Management Tal  Help 4 | |ﬂ
Save ng+8 k =1 = Y =y E, (@ .
[— — Description:
TEETT Y A B
oot S Copy.. SINE BN
Irnipo - .
Compare..  CYM Requirements
Muodule Properties, ., Delete,,,
Page Setup... 2 1.1 Coffee Requirements
Pint Preview,. 3 3T XHIDI= 251, SZ51TIS HIBEC, s mety iesellie
Erint,.. ri+ _ _ Yersion: ¢ 0.0 ¢ 01 & 1.0
Cloce 4 EHHINH= HLPFZ CHZ S0/ EHZCH
— 5 STNINE HIVE ©HE 2, 290/ S0 Buffix: [CVM
& HDZHAIZE f AHED| Uolld EHE 8, 22, AHIPIR 222 2320 Description:
7 EMHI B 21EE s 0l CvM Reguirements formal modulel

8 LA =FEE] 2HEE wEoIck

9 1.2 Change Requirements

10 HI A2 =5, 102 H2] SESE ARSCIMOok Sk

11 SEE 0 EHAI HES T2 SHAHLDH ST

12 WHEFYD SEYUHI HEES F=H 52 HAZ ZU SHAHIDHAISECH

13 SHE YD LI HES F2P S0l PEEC Langel il

14 10E= 910 SFHII HES F23 SFHII HSELC

J o]

Create a new baseline version of the maodule,
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Using baselines(3/5)

= Creating new baselines(cont’d)

E Formal module ‘/Requirements of CYM/CVM Requirem ents® current 1.0 (C¥M) - DOORS
File Edit Miew Insert Link Analysis Table Tools User CHE

Username: sjwoo

HEE & B v = B 8¢ = E | @
[Priority&Risk | |[AlTevels =] | 38 L EBEYHR 24 e BT
R A R o, TS0
1 | 1 CVM Requirements
2 | 111 Coffee Requirements
g I?‘I (| AHLD = SO, SFAHLE HISECH
4 | EPEFALH = HLMFL SHF 20| EHCH
E |Z2EFLH= HLME, ©HZ 8, 420 EHIITCH
HEPHHIZSE 0 AFER] 2HHIA SHE 8, 22, HIDIIE =22 S50
SWMHL EHEe] 212 s=0ICH
2RI SEE 2HE 2 wHolCH

2 Change Requirements
[ ZFED )= 5, w0 Az SHAE A= M0 EHheh

= 910 SHAI HES 23 SHAHL AISECE

<
Exclusive edit mode

4 =

-

Software Procass Improvement Ganter
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KAIST I=C
Using baselines(4/5)

I p—
= Opening baseline
— File - Baseline - View
€ viewBaseline-DOORS ________________ FEE

melect the baseline you want to view

1.0CYM  sjwoo 2007 3

Baseline Set: | Wiy |

Description

CWh Reqguirements formal module

Signaturesl Cancel Help

2007-03-22 KAIST SELAB 66/68



KAIST =
Using baselines(5/5)

= Copy baseline
— File > Baseline - Copy

E Formal module ‘/Requirements of CVM/Copy of C¥M Requirements baseline® current 0.0 - DOORS
‘ CDF.I!.I' EEEEIH-IE - DDDHS File Edit Mew [nsert Link Analysis Table Tools User Change Management TAU  Help

Sl bl |y == FEE RO
Select the baseline you want to copy, [Priorityafiisk ] [AlTevels ~| CEETT N e B
=- Copy of CVM Requirements be [ip s EENCET E‘J
i =-1 C%M Requirerments ==
oo lic o I Cratad Doy I e ar I Lolatad o I Liolotod o IS = 1EVM Requirements

=- 1,2 Change Requiremen

1.OCMVM sjwon 20074 33 15,

Coffee Requirements
A= EMAI, 22HIIE ST
TIHl= HI?HE2F CHE 20| SHZITH

L= AHLW?HE, CHE 8, €50 St

i

o
1 N 1 1 A

5 PHZE W Rl Mol SHE 8, 42, TR 202 233
4 | 7 Il EHES 22 sRI0ICH
] Il sFEF2| 22 1020ICH
Copy to new forrmal rmodulel | Reqguirerments baseline L.§ Change Requirements
MW AHED =5, 103 FR| SHEEE ABZZIHOE ECh

Description: [CVM EFAEF 24
S 9D ZUST HES ST 5 HAS B ST AZAC
YD 223D HES T8 sE0l e,

= 91 220 HEES =2 LM HISSCH

Object ldentifiers

Start at: Prefix:

Include KT B3 [T He
r Headings I:I|'||'_.'.| i '{'.‘” infnjrmatinn Username: sjwoo Exclusive edit mode
0]:8 Cancel Help
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Summary

= |ntroduction of the basic concepts to create SRS in
DOORS

— Folder, project, formal module
— Object
* Heading, text, etc.
= Setting the link between requirements
— Check link module and traceability
= Creation of new attributes
— Understanding system attributes and attribute types
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